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February 18 -25, 2007
Freetown, Sierra Leone
“Heads-up” Digitizing from Scanned Hard-Copy Maps
Part II - Vector Point, Segment and Polygon Editing 1

Objectives:
•
•
•
•
•
•
•

Create a geo-referenced vector map by digitizing (tracing) line features from a georeferenced scanned map.
Setting up the digitizing environment (snapping distance, tunnel factors etc.)
How to check line and polygon topology and correct identified errors.
How to generate polygon topology.
How to capture the scanned map legend in a spreadsheet.
How to create and digitize a point map.
How to link the digitized points (attributes) and segment maps to create a single polygon
map.

Data Sources:
Table 1. Sierra Leone Data Sources available to be used in this lab.
File
Name
Afr_sl300_1lu

Roads

Description

Scanned Hard
copy map:
Land Systems
Sierra Leone.
Roads of the
World (Vmap0)

Rivers

Perennial Water
Courses (VMap0)

soilsgeo

Georeferenced
Scanned map of
Afr_sl300_11u
Map Legend

SLSoilunits

1

Metadata

Format

Scale
Resolutio
n

Coordinate
System

http://eusoils.jrc.it/esdb_archiv
e/EuDASM/africa/lists/csl.htm

.jpg

1:500,000

Local coordinate
system!!

http://www.fao.org/geonetwork
/srv/en/metadata.show?id=128
0&currTab=simple
http://www.fao.org/geonetwork
/srv/en/metadata.show?id=126
9&currTab=simple
NA

ILWIS
Segment

1:1,000,000

GCS_WGS_1984

ILWIS
Segment

1:1,000,000

GCS_WGS_1984

ILWIS
Colour
Composite
.xls
Excel

1:500,000

GSC_WGS_1984

NA

NA

NA

Please quote as:
Kenny F 2006. Heads-up digitizing from scanned hard-copy maps. Manual on data
conversion and data entry (Part I and II), prepared for the FAO project "Land use
planning for optimizing agricultural production” - TCP/SIL/3101a, FAO, Rome.
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Introduction:
In this lab we will follow a number of standardized processing steps that will result in a structured
and georeferenced polygon soils map for Sierra Leone. In this lab we will use the results of
georeferencing we completed in the previous lab (ILWIS raster colour composite map soilsgeo –
provided here).

The processing steps follow a logical sequence as follows:
Steps:
1.
2.
3.
4.
5.
6.
7.
8.
9.

Create a vector layer to contain our segment digitizing results.
Define the digitizing environment (snap and tunnel tolerances).
Digitize segments.
Check segments for segment and polygon topology integrity.
Generate polygons.
Enter the map legend units in a spreadsheet and import into ILWIS as a Domain.
Create a point layer to contain the map attributes.
Digitize a point layer representing the map attributes.
Link the point and polygon layers to produce a final georeferenced structured polygon map.

Caution:
Learning to digitize can be quite frustrating but with experience you will find it becomes very
routine. It is advisable if you have access to someone with digitizing experience that you spend
some time with them and have them explain some of the finer point and have them share their
experiences/tricks with you. The ILWIS on-line help is also a good resource and it is highly
recommended you read through and have ready access to the relevant section as you are digitizing.
You will also find that all software digitizing implementations are different, but once you have
mastered one package, learning another is only an incremental task which is only half as painful as
learning the first package!

Processing:
1. If ILWIS in not already opened, open it. (Start Æ ProgramsÆ ILWIS3.3).
2. Create a local directory on your workstation and copy across the lab data (for a listing of
files see table 1).
3. From under the Help pull-down menu at the main ILWIS window select Help on this
Window. From the Contents tab, scroll down and open and read the section: Editors Æ
Segment Editors Æ Functionality Æ Working with a Mouse. When finished open and
read about the Point Editor and then finally about the Polygon Editor. Keep these pages in
mind and use them as a reference as you work through this lab.
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4. Now we are going to open the colour composite soilsgeo that we created in the previous
lab. Navigate to your local directory and double-clicking on the icon for soilsgeo and then
selecting the colour composite button.
5. Accept the default display options as below, by selecting OK.

6. This is a very large file (195 Mbytes) and it may take a few minutes to load. Explore the
map and notice the legend and the map surround have been cropped off as per our
instructions in the last lab. Also observe the coordinate system. This map could be
translated (File Æ Import Æ GDAL) to many different formats and imported with full
georeferencing intact to almost any GIS system. You can close this map window.
7. Now we are going to create a segment map of the very same extent as our soils map to
contain our segment digitizing results. From under the File pull-down menu at the main
ILWIS window, select Create Æ Segment Map. This will initiate the two following
windows. Call your Map Name: soilsegments. Use the drop arrow beside Coordinate
System to select LatLonWGS84 (you will recall the same as our soils maps).
8. Enter the map extents (as below) to be consistent with our soils map. Be careful that you
specify all coordinates as N (north) of the equator and W (west) of the Prime Meridian.
Select the create button beside Domain to create a Domain that will describe our segment
map. The parameters for the Domain are shown on the window to the right (Create Domain
Window). By selecting an Identifier Domain Type and 10000 records – ILWIS will auto
attribute each digitized segment with an incremented unique ID. For more details, select
the Help button on either of these windows. Select OK at each window. A Domain
Identifier window will open indicating that it has been created you may close it. Later in
this lab we will be creating a Point map in a nearly identical fashion.
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9. Notice that the empty segment Map called soilsegment has been opened for you and you
are already in edit mode. Now we will add our georeferenced soils map that we plan on
digitizing. From under the Layer menu of your map window select Add Layer and scroll
down and select the raster composite soilsgeo and open it as a colour composite. Select the
Create Pyramid Layer check box and accept all other default display options.
10. You are almost ready to start digitizing segments, but first we have to set some digitizing
tolerances. From under the Files tab at the Map window (now called Segment Editor )
select Customize... Most of the defaults shown at this window are acceptable. Click the
Help button and read about each of these settings and how they control during your
digitizing. Snapping is a very important function when you want segments connected and
polygons closed (called topology). Snapping helps ensure that segment end points (nodes)
share exactly identical coordinates. Tunnel tolerance controls how your coordinates from
consecutive digitized points are generalized and stored. It is important to experiment with
both the snap and tunnel tolerances in order to ensure you are accurately capturing the level
of detail you desire and the original map can accomodate. Through experimentation the
following setting shown in the window below work well to capture the line work from this
particular map. With your setting set, select the OK button.
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11. There is an option in ILWIS digitizing called “stream mode”, where a user traces a feature
while holding the left mouse button down. This results in the system auto-creating
coordinates for vertices (points along a line). In this lab we are not going to use this
function. We are going to single left-click at each vertex to precisely control coordinate
placement.
12. Zoom into any area of the image (such as below), with enough detail that polygon
boundaries can be viewed as more than one pixel in width. Pick up the pen (insert mode –
the red circle as shown below). Single-clicking at the start of a line you want to digitize to
initiate a segment and then single right-click while tracing around the feature to define the
feature. To finish a segment (i.e. insert a node), double click. When ending a segment by
double-clicking a window will open asking you to identify the segment with a unique ID.
Call this segment 1 and select OK. For future segments, label then in order (e.g. 2, 3 , 4
etc.).
13. To continue digitizing along the same feature, single click very close to the last end node
(small yellow box) and your snapping setting will actually “snap” your new segment
directly to the end node of your previous segment. These two segments if properly
“snapped” will have shared coordinates. Trace around an entire feature. When you want to
close a segment and link it to another segment (for example to create a polygon) single
click very/extremely close to the selected existing node and again your snapping
environment will place your segment node directly on top of the closest node.
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14. Digitize several small and adjacent polygons in this fashion.
15. Notice there are several other editing tools available for you to use on the tool-bar
beside the insert-mode tool (in red circle above). These tools, Select, Move Points
and Split/Merge Mode are essential to control your digitizing. Notice that if you
slowly pass over these tools with your mouse, the name of the tool will appear and
that the names of these tools describe their function. Experiment with each of these
tools using your digitized segments.
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16. Open the On-Line help Help Æ Contents Tab Æ Editors Æ Segment Editors Æ
Toolbars and read the full description of how and when to use each of these tools.
The best way however to learn about these tools is to experiment with them.

17. After you have digitized a couple of polygons we can now test to determine if the
“topology” (spatial relationship between points/lines/polygons) is in fact clean of
errors. There are three functions to assist you in this task. From the Segment Editor
window under the File ÆCheck Segments you will find these tools. They are called
1) Self Overlap, 2) Dead Ends and 3) Intersections. The Self Overlap is a check to
ensure no segments are directly overlain. Dead Ends is a check to determine if there
are any unconnected nodes. Intersections is a check to determine if segments are
intersecting without a node. It is important to note that all intersections must have a
node.
18. Running these tests will highlight many, but not all the digitizing errors you have
made. Shown below are the messages these routines will generate for you. These
routines will also assist you by zooming into the error locations. Once you are
zoomed into the digitizing error and have identified the problem (sometimes you have
to zoom in very far!) you can again use the editing tools (select/delete, split, merge,
move etc.) to resolve the problem.

19. A most helpful function to view the results of your editing is the Redraw button on your
toolbar. At first you may find it difficult to identify and correct topology errors, but with
practice you will get very fast – as you come to expect familiar patterns of problems!
20. Do not forget to frequently save your data (File Æ Save) while editing. Once your data has
passed all three tests successful, you can then create polygons. To do so. from under the
File tab, select Polygonize. This will initiate a window that gives you several options (as
shown below). We are not going to keep this polygon file as we are only going to be
testing our data. Select the Unique Identifier check box, which will simply auto-generate a
unique attribute for each polygon that you have digitized. Later in the lab we use the Label
Points options to control the attribution of the polygons according to the map legend. Give
your polygon map a name and check the Show box. Checking the Show box just displays
your map once polygon generation has been successfully completed.
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21. If polygon errors are detected while attempting to create polygons ILWIS will again
guide you to correct these. Continue to run this task till all errors are corrected and a
polygon file has been successfully completed. Once you have corrected all errors
ILWIS will prompt you for display settings for your new polygon map, accept the
defaults. View your Polygon map and once finished you may close this map and if
desired delete it.
22. The next step in the process is to create and then digitize a point map. This point map
will be used to contain the polygon attributes (in our case soil map unit names and
indentifiers). To save you time, I have already entered the soil units in an Excel
Spreadsheet. To digitize additional maps you would have to create such a legend.
Go to your working directly and open the spreadsheet SLSoilunits.xls . What you
see here (as below) are the map unit names with the same unique identifier as on the
scanned map. To double-check this open the scanned map Afr_sl300_1lu.jpg, zoom
in and pan over to view the original map legend. We are going to use this
information to create an ILWIS Domain for our point map.
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23. Similar to how we created the Segment map, in Step 8 we must now also create a
Point map. Back at the main ILWIS window, from under the File tab, select Create
Æ Point Map. This will initiate a series of three windows that are all linked. In the
first window presented, enter your Map Name, a Description, Map Extents (Min
Latitude, Min Longitude etc.) and from the drop-down menu beside Coordinate
System select LatlonWGS84. Select the Create button beside Domain – this will
initiate the second window (as below) where you must specify a Domain Name,
identify your Domain Type as a Class Domain and an appropriate Description. Once
you have entered these values at the second window select OK. Selecting OK
initiates the third and final window (as below). Here you are expected to add your
map units (Class Names) and associated Identifiers (Code). You could enter these
data manually with the tools provided at this window. In our case we will Cut-andPaste these values from our spread-sheet SLSoilunits.xls. Cut-and-Past these values
into your Domain (as below). Your Domain will be saved automatically. Once your
values are entered, you may exit this window. You may also now finally select OK
within the Create Point Map window.
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24. After creating this Point map ILWIS will automatically open an empty Point map in
a window called Point Editor: soilunipnts and you will be directly in edit mode.
As a first step it is most helpful if you load both your recently digitized segment
map (soilsegments) and the scanned soils map (soilsgeo), as below. With this
information in the background, you are ready to digitize the attributes. The tools
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used for segment digitizing are the same tools that can be used here. If you take the
pen (insert mode) and click within the map, you will note that the values within
your Domain are presented for you to select the appropriate attribute. Double click
on the appropriate unit. Note that you can use the keyboard up and down arrows to
move within the point map units presented. Use this method to add a single
attribute each polygon you have digitized.

25. Once you have finished attributing each polygon save your digitizing (File Æ Save)
and select the Exit Editor button.
26. With both a segment map (checked for polygon topology – step 21 above) and a point
map created you can now generate a polygon map using your point attributes. To do
so, you have to go back into the segment editor. In a map window with your segment
map (soilsegments) loaded from the Edit pull-down menu select Æ Edit Layer Æ
seg soilssegment.
27. As we have done before we will create polygons from this segment map – this time
however we will use our just created point map to control the attribution. From under
the map window File pull-down menu select Polygonize (as below). This time
select the Label Points option and specify your point map file (in my case
soilunitpnts). Give your new Output Polygon Map an appropriate name. ILWIS
will apply the Domain from your point file directly to your new polygon map. If you
select the Show button, once the polygon map has been created it will be
automatically displayed for you
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28. A portion of the final Polygon map!

12

